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1. Introduction 

The primary purpose of the AEMS Data Centre software is to download readings stored by the 

system to the online server. 

You can also manage the users who can access the data and control who will receive event 

notifications from the system. 

2. System Requirements 

The AEMS Data Centre software requires a PC running Microsoft Windows XP SP3, Microsoft 

Windows Vista SP2 or Windows 7. Microsoft .NET Framework V2 and Windows Installer 3.1 are 

also required. These components will be downloaded and installed if required. 

Your PC must have a connection to the Internet. A broadband connection is recommended with 

a speed greater than 512KB/S. 

3. Installation 

1) Open your Web Browser and visit http://df3.datafield.com/AEMSDS/Download. When 

the web page appears click the Install link at the bottom left of the page. If any of the 

displayed required components (Microsoft .NET Framework and Windows Installer) are 

not already installed on your PC, the installation process will automatically install them. 

The following screens apply when installing with Internet Explorer 7. 

 

2) When the follow message appears, click the Run button. 
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3) Depending on your computer’s security policy you may see the following warning. This 

confirms that the software has not been tampered with. Click the Run button. 

 
 

The following is displayed briefly: 

 
4) When the Application Install – Security Warning appears, check the publisher name is 

Geotechnical Instruments (UK) Ltd and then click the Install button: 
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5) Download and installation will proceed and the application will start automatically. 
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4. Running the Software 

To start the software click the Start button, find the Geotechnical Instruments menu and choose 

Geotech AEMS Data Centre. 

Tip: With Windows Vista/7 click the Start button you can search on “AEMS” to find the menu 

option more quickly. 

When the software starts enter in your User Name and Password. These will be provided by 

Geotech by email when you sign-up for AEMS Data Centre. 

 
There will be delay after clicking Login whilst your project settings are loaded, then the main 

application window appears: 

 

 

4.1 Forgotten Username or Password 

If you have forgotten your username or password, click the Forgotten your username or 

password? Link on the login window and enter your email address. 

A new password will be emailed to you. When you next logon you will be prompted to change 

your password. 
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4.2 Exiting the Application 

Click the X in the top right corner or choose Exit from the File menu. 

 

5. Software Operation 

Your AEMs has been preconfigured by Geotech prior to installation to record the channels 

requested at a specified interval, for example every 15 minutes. The AEMS system transmits its 

data via a GPRS or Ethernet connection directly to the Geotech server where the data is safely 

held for up to ninety days (varies according to system configuration). You will receive an email 

notification prior to automatic deletion of the data. 

Samples are taken at the specified interval and are held locally on the logger until they are 

transmitted to the server.  

To change sampling settings on your AEMs system you will need to contact Geotech, who can 

make some changes to the system remotely. 

5.1 Main Window 

The main window of the application has two tabs, System and Settings. The System tab 

maintains all options relating to the operation of the currently selected system. The Settings tab 

allows you to configure your settings. 

5.2 Selecting Your System 

If you have more than one Aems system select the one required by selecting it from the drop 

down list on the System tab. 

5.3 Retrieving Data 

After selecting the system you download readings to your PC by selecting the Data tab. 

By default readings are saved as Comma Separated Value (CSV) files, although they can be saved 

in XML format. 

The Data tab shows the following information: 

Most recent available reading shows the time stamp of the most up-to-date data available for 

the selected system. 

Your most recent download shows the time stamp of the most recently downloaded reading 

from the server for this system. You can see a history of previous downloads by selecting the 

Download History tab. 

From and to date/time controls show the time range of data to download from the server. 
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To begin the transfer, click the Get Data button. Download of readings will begin.  

NOTE: If you have select a large set of data, many weeks for example, you will have to wait 

several minutes for the download to complete. 

We recommend that you schedule regular downloads of readings. 
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5.3.1 Saved Readings Folder 

When you download your readings they are automatically named and saved to disk. The folder is 

in AEMS/Downloads/<Project>/<Unit> below your “My Documents” folder. You can change the 

default save location by changing your settings on the Settings tab. 

Files are named automatically with a named based on the project, unit and reading time range. 

Aems_<Project>_<Unit>_<StartTime> to <End Time>.csv 

To open the folder in Explorer containing readings for the selected system click the 

Open readings folder button on the Data tab. 

5.3.2 Viewing Downloaded Data 

There are three ways to view the data once it has downloaded. 

Within AEMS Data Centre 

You can view the data directly in Aems Data Centre once it has downloaded. 

Opening the saved readings file 

After the file has been downloaded and saved, a link to the file is displayed above the readings 

table. Clicking this link will open the file using your computer’s default file viewer for CSV files. If 

your computer has Microsoft Excel installed this is usually Excel. 

Opening the readings in Microsoft Excel 

If your computer has Microsoft Excel installed you can open the readings in Excel by clicking the 

Open In Microsoft Excel button. 

 

5.4 Unit Details 

The Unit Details tab simply displays the name and description of the system. The parameters 

cannot be changed. 

5.5 Channels 

The Channels tab shows the data channels recorded by the AEMS system. The parameters 

cannot be changed with this application. To reconfigure the recorded channels or samping 

interval please contact Geotech. 
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5.6 Notifications 

AEMS systems generate event notifications for various events: 

 Device Error 

 System reset (and start-up) 

 Calibration Failure 

 FAU Device Error 

 FAU Service Due 

 Local disk space low 

 Local disk space full 

 FAU Communications failure 

 PLC Communications failure 

 Calibration gas bottle low or empty 

You can configure registered users to receive these event notifications by SMS or Email. 

Select the system and then click the Notifications tab. 

5.6.1 Notifications List 

This list shows all possible notification types that can be generated by the system along with a 

count of the number of active recipients for each notification type. 

5.6.2 Users and Format 

For the selected Notification type in the Notifications List this tree view allows you view and set 

who should receive the notification and by what means, either SMS (text message) or email. 

Expand the notification type in the tree, and then expand the user who should receive the 

notification. This will reveal their email address and SMS phone number (if specified). Tick one or 

both of the types of notification. 

Repeat this for other users and then click the Apply button. 

Activating Changes to SMS Notifications 

If you have specified a change to SMS recipients then the AEMS system will need to be restarted 

before the change becomes active.  

These updates will cause the AEMS system to restart automatically when it next connects to the 

server. 

Please note that when the update happens is also determined by the connection interval of the 

remote AEMs system. If a system is configured to only connect once every six hours, then it 

could be up to six hours before the update is received. 
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5.7 User Management 

If you are a designated Administrator of your Project you will have access to the User 

Management tab. This tab allows you to add and remove users from the system. 

5.7.1 Adding a New User 

To add a new user select the tab and click the New User button. Complete the form and click 

Save. 

5.7.2 Removing a New User 

Users cannot be deleted, but they can be deactivated to prevent them from being able to logon 

to the system.  

To remove a user, click the user name and then the left arrow. The user’s name will move to the 

Available Users list and they will no longer be able to access the system. 

5.8 Download History 

The download history window shows you a complete history of requests for data for the 

selected system. 

Start Time and End Time are time range of the readings obtained. 

Time Downloaded is the time that the request was made. 

Client Computer is the identity of the computer that made the request which is a combination of 

computer name and IP address. 

User is the AEMS Data Centre login name used. 
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6. Configuration 

The software settings can be configured by choosing the Settings tab.  These settings affect how 

the software operates on your PC and not the configuration of the remote AEMS system. 

6.1 Settings 

Application settings determine how the software is configured on your computer. 

To access the settings tab click the Settings tab and then click lower the Settings tab. 

NOTE:  Remember to click Save Changes after making settings to any of these parameters. 

6.1.1 Downloading Files 

Download folder 
 

Download folder determines where data files received from the AEMS are 

stored locally on your PC. To change the default location click the button. 

File type Files can be stored in one of two types: CSV or XML. CSV is ideal for viewing 
with a spreadsheet application such as Microsoft Excel. 
XML file format is more suitable if you wish to transfer the data into a 
database using third-party software. 

Overwrite 
existing files 

Tick this option to overwrite existing download reading files. 

Numeric 
accuracy 

Enter the number of decimal places you wish to specify for numeric data. 

6.1.2 Web Service 

Web Service URL Displays the current URL of the Web Service the software connects to. You 
cannot change this setting. 

6.2 My Profile (General User Settings) 

To edit your email address, SMS notification number or password choose the Settings tab and 

then choose the My Profile tab. 

User Name The log in name and full name of the current Aems Data Centre user. 

Email 
 

Specify the email address you wish to use to receive event notifications from 
the AEMS system. This must be a valid Internet email address. 

SMS If you have a phone or device capable of receiving notifications by SMS you 
can enter the number here. Please enter the number in international format. 
  

Password To change your login password enter your existing password into Current 
Password, then enter your new password into both New Password and 
Confirm Password and then click the Change button 

Computer 
Identity 

This shows the unique identifier of your PC and log-in name that is used by 

the server to record data download activity from your PC. 
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7. Data Deletion Notifications 

Your data is only stored on the server for 90 days, after which it is deleted. The time is based on 

the time the reading was taken, not the time at which it arrives on the server. 

To prevent data loss the AEMS system will notify you at your registered email address 14 days 

prior to deleting data that is over 90 days old. 

The server sends email notifications weekly to registered users identifying data that will be 

deleted and which time ranges have been deleted from the server. The report groups data by 

the time it will be deleted and there is a separate section identifying data that has been deleted 

since the last report. 

IMPORTANT NOTES 

 It is the customer’s responsibility to ensure that they have downloaded their data within 

the 90 day time frame prior to automatic deletion from the server. 

 It is the customer’s responsibility to ensure that once data has been downloaded it is 

backed up. Geotechnical Instruments shall not be responsible for the data once it has 

been downloaded to a client PC.  

 Data is irretrievable from the server once it has been deleted. 

 


